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CSiBridge v24.1.0 Release Notes
© 2022 Computers and Structures, Inc.

Notice Date: 11-October-2022

This document lists changes made to CSiBridge since v24.0.0, released 11-March-2022. Items marked
with an asterisk (*) in the first column are more significant.

Analysis
Enhancements Implemented
* Ticket Description
* 8404 A change has been made to the reporting of joint reactions and base reactions for nonlinear

static and staged-construction load cases. Previously joint-force loads and acceleration loads
applied at restrained degrees of freedom were excluded from the reported joint reactions at
these degrees of freedom, including their contribution to overall base reactions. This was
intentional for matching the reactions to the force reported in the connected frame objects
when performing pushover-types of analyses. However, this is now changed to be consistent
with the reactions reported for most other types of load cases, including linear static,
nonlinear direct-integration time history, and modal time history, including FNA. This is a
reporting issue only. No other results are affected, including the reactions at flexible
supports (spring support and one-joint links). The only change in restraint reactions will be
due to joint-force loads applied directly on the joint and apportioned acceleration loads
from connected objects, including from mass directly assigned to the joint.

* 8947 The speed of influence-based moving-load analysis has been significantly improved for
certain models. The third phase where vehicle classes are permuted on the various lanes is
now much more efficient when there are multiple vehicle-class assignments on a larger
number of lanes. The first phase where the influence lines are computed, and the second
phase where vehicles are moved along and across the lanes, are not affected. Results are
not affected.

API
Enhancements Implemented
* Ticket Description
* 8529 The following enhancements have been made to the Application Programming Interface

(API): (1.) The new function cHelper.GetObjectProcess() can be used to attach to any running
instance of CSiBridge given its process ID. (2.) A new command "Set as active instance for
API" has been added to the Tools menu. This command will make the current instance of
CSiBridge the "active instance" so that it will then respond to subsequent calls to
cHelper.GetObject() function. If the current instance is the active instance, then this
command is disabled. In either case, the process ID of the current instance is displayed for
use with the new function cHelper.GetObjectProcess(). (3.) A new interface cPluginContract
has been added to simplify plugin development. (4.) Speed has been improved for external
.NET clients that call the API by chaining properties and methods (e.g.
mySapObject.SapModel.PointObj.GetElm) in deeply nested loops.
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Bridge Design and Rating
Enhancements Implemented
* Ticket Description
* 2243 The strength design of substructure (bent) columns has been added according to the

AASHTO LRFD 2020 code. Design is controlled by defining one or more Design Requests
which can specify a set of load combinations, bent columns, column stations, and other
parameters to be considered. Similar columns and stations with similar reinforcement can
be designed together. The cross section used to calculate capacity can be different from that
used for demand, so that different section shapes, materials, and rebar layout can be quickly
iterated for design. Results for each Design Request are provided in the form of an Excel
spreadsheet that can be used for further calculations and for inclusion in reports. The
spreadsheets include plots of the PMM interaction for visualizing demand and capacity.
Design results are also available in database tables for display, export, and reporting.

* 8786 Bridge seismic design has been enhanced to add a new measure for the displacement
demand and capacity of the bents. Previously, deformation was always measured as the
difference between the transverse or longitudinal displacement at the top of the bent and
the bottom of the columns, hence measuring only the deformation of the bent itself. The
new measure is simply the transverse or longitudinal displacement at the top of the bent,
hence measuring the deformation of the entire substructure, including the foundation. The
original "Bent Only" displacement measure is consistent with the formula-based capacity
measures for Seismic Design Categories B and C, and will always be used for these cases. The
new "Bent Plus Foundation" measure is more consistent with the nonlinear static pushover
analysis used for Seismic Design Category D, and hence is generally recommended for this
case. The new measure will tend to produce more conservative demand-capacity ratios
when the foundation is elastic and flexible, especially for more ductile columns. On the
other hand, it may be less conservative for models where there is substantial plastic
deformation in the foundation before column yielding, or for more massive foundations
where the demand comes from the foundation itself. New models will default to the new
full-substructure measure, while older models opened in the new version will use the bent-
only measure unless subsequently changed.

Bridge Modeler
Enhancements Implemented
* Ticket Description

8249 An enhancement has been implemented for the Bridge Modeler where parametric variation
can now be assigned to the offset from the reference point to the insertion point for user-
defined bridge sections. This is applicable to spine models, area models, and solid models.
Note that the variation of the individual polygon points in the user-defined bridge section is
only available for the spine model.

8284 The Bridge Modeler has been enhanced for the editing of user-defined bridge sections in
Section Designer. Previously the lines drawn to specify girder centerlines needed to extend
significantly past the top and bottom slab reference lines in order to be properly recognized.
The tolerance has been changed so the girder centerlines drawn just to the slab reference
lines, as well as those that extend beyond the slab lines, will be recognized.

Data Files
Enhancements Implemented
* Ticket Description

8273 Three new section-property database files have been added for steel sections produced by
certain Indian manufacturers: (1.) TATA_Steel.xml, containing data for steel Pipe/Tube
sections manufactured by the TATA group of companies. (2.) Jindal_Steel.xml, containing
data for steel I/Wide Flange sections manufactured by Jindal Steel Ltd. (3.) APL_Steel.xml,
containing data for steel Pipe/Tube sections manufactured by APL Apollo Ltd.
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* Ticket Description
8487 A built-in material library has been added for Canada. The library contains steel materials

per the CSA G40.20-13/G40.21-13 standard, concrete materials per the CSA A23.3 standard,
and rebar materials per the CSA G30.18:21 standard.

8770 The Chinese frame-section database has been updated where section properties for some of
the frame sections have been corrected and several new frame sections have been added
for I/Wide Flange, Tee, Angle, and Pipe shapes.

Database Tables
Enhancements Implemented
* Ticket Description
* 3958 An enhancement has been implemented that adds two new database tables, "Bridge Object

Forces with Tendons" and "Bridge Object Girder Forces with Tendons". These complement
the existing tables "Bridge Object Forces" and "Bridge Object Girder Forces", which exclude
tendon forces in the results. The two new tables essentially provide the secondary prestress
forces on the full bridge section or the individual bridge girders, respectively. These four
tables now provide the equivalent data that is available on the Bridge Object Response
Display form when toggling the Include Tendon Forces option.

Design – Concrete Frame
Enhancements Implemented
* Ticket Description

2114 Concrete frame design for the Eurocode 2-2004 code has been enhanced to consider the
extra longitudinal reinforcement required due to shear according to equation 6.18 of
Eurocode 2-2004 clause 6.2.3. This enhancement was previously released in CSiBridge
v24.0.0, but was inadvertently omitted from the Release Notes.

Installation and Licensing
Enhancements Implemented
* Ticket Description
* 8268 The version number has been changed to v24.1.0 for a new intermediate release.

Loading
Enhancements Implemented
* Ticket Description

8929 An enhancement has been implemented to update the New Zealand vehicle library to
incorporate changes introduced in the NZTA Bridge Manual v3.4.

Results Display and Output
Enhancements Implemented
* Ticket Description

6587 An enhancement has been made to allow users to choose colors for Hinge State and Hinge
Status for analysis of models with nonlinear frame hinges. This can be accessed using ribbon
command File > Settings > Output Colors or menu command Options > Color > Output. The
colors are now consistent in deformed-shape display, plots of hinge force-deformation, and
in the forms where the nonlinear properties are specified.

User Interface
Enhancements Implemented
* Ticket Description

6541 An enhancement has been implemented to expose additional DirectX settings that can be
set for each view window, providing more advanced control of the graphical display. These
can be found under the ribbon command Home > View > More > DirectX View Settings or
the menu command View > DirectX View Settings.
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Analysis
Incidents Resolved
* Ticket Description

8289 An incident was resolved where link elements with a triple-pendulum property that had the
U2 and/or U3 degrees of freedom set to linear did not use the specified linear effective
stiffness in nonlinear load cases. The triple-pendulum link property has been changed so
that now the U2 and U3 degrees of freedom are always nonlinear, similar to the U1 degree
of freedom. Older models that had triple-pendulum link properties with the U2 and/or U3
degrees of freedom set to linear will have these degrees of freedom changed to nonlinear
upon opening the model in CSiBridge v24.1.0. For such older models, the nonlinear
properties will default to zero unless they had been previously defined, and this may make
the model unstable or change the behavior from the previous version. Note that such
models are uncommon, but they should be updated with realistic nonlinear values for
affected triple-pendulum property definitions.

* 8438 An incident was resolved where link elements with a viscous damper property (Linear with
non-zero damping coefficients, Exponential Damper, or Bilinear Damper) could experience
forces that did not correspond to the velocity of the element. This issue only occurred in
direct-integration time-history analyses where the Geometric Nonlinearity option was set to
"P-Delta plus Large Displacements". When this issue occurred, the damper elements notably
did not return to a small or nearly-zero force value after the structure had come to a
standstill.

* 8515 An incident was resolved where the flexibility of fiber hinges in frame objects was not
included in the stiffness-proportional damping used for direct-integration time-history load
cases. This issue was most apparent when all or most of the frame-object length was
modeled as fiber hinges and resulted in very large stiffness-proportional damping forces
which could prevent the frame object from experiencing significant deformations in time-
history analyses. The effect on frame objects with fibers hinges that covered a small part of
the object length was significantly less pronounced. This issue was only present in CSiBridge
v24.0.0 and did not affect older versions of the software. This issue only affected direct-
integration time-history load cases where stiffness-proportional damping was used. Models
that were affected by this issue should be rerun.

* 8762 An incident was resolved where, when target-force loads were applied to a frame object
with time-dependent material behavior (e.g., creep/shrinkage) during a stage that had non-
zero duration, the target-force iteration did not check for target-force convergence at the
end of the stage. When this occurred, the resulting force in the frame object could be quite
different from the specified target value. This issue only affected nonlinear staged
construction load cases where time-dependent material behavior was enabled. Note that
this issue did not affect the equilibrium of the structure, but rather the possible difference
between the specified target force and the load that was actually applied.

* 8825 An incident was resolved where a model that had P-M3 Fiber hinges assigned to frame
objects may have experienced larger than expected stiffness-proportional damping in linear
direct-integration time-history load cases when stiffness-proportional damping was enabled.
This issue was more pronounced when the hinge length was a significant portion of the
length of the frame. This issue only affected models where the analysis model for nonlinear
hinges option (Analyze menu > Analysis Model for Nonlinear Hinges) was set to "Model
Hinges as Separate Link Elements". This issue did not affect static, modal, or nonlinear
direct-integration time-history load cases, and it did not affect models where the hinges
were modeled within elements. This issue affected CSiBridge versions 22.1.0 to 24.0.0.
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* Ticket Description
8852 An incident was resolved where the reported joint reactions did not always include the load

applied to the joints for certain types of linear load cases, whether the load was applied
directly on the joint or on connected elements. These load cases included linear direct-
integration time history, linear frequency-domain time history, steady state, and PSD types.
This issue only affect the reported reactions at restrained joints that included force loads,
acceleration loads, and/or temperature/strain loads from connected elements, as well as
force loads on the restrained joints themselves. Similarly affected were the reactions due to
ground-displacement loads applied at joints grounded by springs. Reactions due to
displacement loads on joints grounded through restraints or one-joint links were not
affected. This was a reporting error only. No other results were affected.

8962 An incident was resolved where the analysis could not be cancelled from the analysis
monitor in the following situation: The Analysis Process Option had been changed to
"Separate Process", then the parallel Load Case Option had been enabled, and then the
Analysis Process Option had been changed back to "Auto" or "GUI Process" before running
the analysis. These options can be set using the command Analysis > Analysis Options >
Advanced SAPFire Options. When this occurred, the analysis could still be cancelled using
the Cancel button on the main window instead of on the analysis monitor.

Bridge Design and Rating
Incidents Resolved
* Ticket Description
* 8294 An incident was resolved for steel I-girder bridge superstructure design and rating where a

design or rating request could fail to run for a bridge object having more than one span if
some girders were continuous and others were not continuous across a single-bearing bent
support. To be considered as continuous, the steel I-girders on either side of the support
must have the same transverse locations and the same elevations at the top of their webs.
When this error occurred, the corresponding design and/or rating results were not available.
This error affected versions 23.3.0 to 24.0.0.

* 8340 An incident was resolved for the bridge superstructure design and rating of steel U-girder
bridges where design and/or rating requests would fail to run when there were girder-local
section cuts between two general (full-width) bridge section cuts. The girder-local cuts could
have been created by the Bridge Modeler for capturing the response at section transitions,
staggered diaphragm, or splices. This error could be avoided by adding user discretization
points at these local cut locations, this creating general section cuts. This error only affected
version 24.0.0.

8477 An incident has been resolved for bridge superstructure design where the design
optimization feature was not available for the AASHTO LRFD 2020 code. Design results were
not affected, only access to the optimization feature.

8588 An incident was resolved for the bridge superstructure design and rating of steel I girder
bridges where the design or rating request could fail to run if any of the steel I girders was of
a nonprismatic section type that included two adjacent segments, one referencing a
standard I-section and the other referencing a hybrid I-section, and either (or both) of the
two segment lengths was shorter than 2 inches (5 cm). When this occurred, results were not
available. This is not a common case.

8901 An incident was resolved to correct the derivation of the nonprismatic tension-flange
capacity. In the previous version the flange tension capacity was based on panel minimum,
while now it is based on the local section-cut Rh factor. The previous derivation would
typically result in a more conservative design/rating. Impacted deck section types include
steel I-girder with nonprismatic hybrid sections. Impacted design/rating requests include
AASHTO LRFD Steel I Strength for all AASHTO versions.

8924 An incident was resolved for bridge seismic design where the design would fail to run if (1.)
the Seismic Design Category was D, (2.) the Longitudinal Pushover Analysis option was set to
"Full Bridge Along Chord", and (3.) the number of the girders in the one of the spans was
more than that in the previous span. When this happened, an empty error message was
displayed, and the seismic design process terminated without results. Results for other types
of analysis and design were not affected.
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Bridge Modeler
Incidents Resolved
* Ticket Description

6283 An incident was resolved for the Bridge Modeler where the staged-construction operations
"Change Section" and "Change Section & Age", when applied to link objects in a bridge
group, would be changed or deleted if the associated bridge object was updated.

7402 An incident was resolved for the Bridge Modeler that addressed two issues for the concrete
solid-girder bridge section: (1.) In the bridge section data form, an irrelevant error message
occurred when the overhang length was set to zero; (2.) Girder spacing was not adjusted
accordingly when the bridge width and/or the overhang lengths were changed. Results
agreed with the model as generated.

7410 The Bridge Modeler now provides a warning when support-bearing overwrites are specified
for invalid bearing numbers. For girder-by-girder bearing assignments, this means for a
bearing number greater than the number of girders, except for the "Ext. Girders Sloped
Max" concrete box-girder bridge section where bearings are also not available under the
first and last (exterior) girders. A similar warning will be provided when the bridge object is
updated if the bridge section was changed after valid support-bearing overwrites had been
assigned.

8320 An incident was resolved for the Bridge Modeler where the generated geometry of the top
flanges of steel U-girders and their adjacent slab area objects would be modeled incorrectly
if the parametric variations were assigned to the bridge-width related dimensions and the
"Girder Layout Layout" option in the bridge-section data form was set to "Straight Line".

* 8323 An incident was resolved for the Bridge Modeler where a bridge object following a curved or
kinked layout line with non-zero grade, and that was modeled using area or solid objects,
could generate slightly incorrect longitudinal joint coordinates for some of the area/solid
objects. The error was proportional to the vertical distance from the layout line, which is
usually located at the top of the superstructure. When this occurred, the links that connect
the bottom of the superstructure (either bottom of the bottom slab or bottom of the
girders) to the top of the support bearings sometimes did not properly connect to the
superstructure, which could cause the model to be unstable. This could be avoided by
setting the grade to zero. This error only affected version 24.0.0.

8349 An incident was resolved for the Bridge Modeler where area (shell) objects representing the
web of steel U-girders could could be generated with slightly incorrect vertical coordinates if
the U-girder depth was defined as tapered. When this occurred, the analysis would not run
because the generated area objects were too distorted.

8476 An incident was resolved for the Bridge Modeler where the horizontal geometry of a bridge
tendon generated for a curved bridge could be incorrect if the bridge was oriented in
approximately the North-South direction such that the tendon curved from a Northeast to
Northwest direction, Southeast to Southwest direction, or vice-versa. When this occurred,
the effect was visibly obvious and results agreed with the model as generated.
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* Ticket Description
8502 An incident was resolved that addressed two issues with rail tracks: (1.) The frame objects

generated to represent rail tracks could be generated in an unexpected location if there
were two or more area objects directly below the rail, such as for a double-deck bridge
structure. A new option "Objects Loaded by Rail Track" has been added to the rail-track
definition to help reduce the ambiguity when multiple area objects are found below the
track. Three choices are available: Program Determined, Bridge Object, and Group. For
Bridge Object, only the area objects representing the top slab of the specified bridge object
will be considered. For Group, only the area objects in the group will be considered. If the
group contains multiple area objects below the rail track at the same location, then the
results could still be ambiguous. For Program Determined, all bridge objects referencing the
same layout line as the rail track will be used; if none, then all bridge objects will be used. If
there are no bridge objects, then all area objects in the model will be considered, with the
possibility of an ambiguous result. For all of these options, if no area objects can be found
under any portion of the rail track, then the rail track will not be generated and a warning
message will be provided. If at least one area object can be found below any portion of the
rail track, the track will be generated and will connect only to the specified area objects;
portions of the rail track outside the range of the specified area objects will be grounded,
even if other area objects are present below the rail track. (2.) When a rail-track support
property (say "B") was defined by copying a previously defined property (Say "A") and then
modifying it, the generated links representing the copied property ("B") would actually take
their values from original property ("A"). This will no longer happen when copying properties
in the new version. However, affected models from previous versions, when opened in the
new version, will need to be manually corrected by deleting the copied property ("B"),
redefining it, and then reassigning it to the rail tracks.

8538 An incident was resolved for the Bridge Modeler where, for user-specified control points (in-
span hinges, full-width splices, full-width external diaphragms, and user discretization
points) with a bearing angle set to "Default", the corresponding generated section cut would
be created perpendicular to the layout line whenever possible without crossing a skewed
support. This could cause poor slab meshing of the slab when very near to skewed supports
and thus reduce the accuracy of the analysis results. Now for these user-specified control
points with a "Default" bearing angle, the orientation will be adjusted (skewed) near skewed
supports to avoid poor slab meshing and therefore may not be perpendicular to the layout
line. This can be controlled by specifying a desired bearing angle rather than using "Default",
but care should be taken to make sure the resulting model is reasonably meshed. The use of
staggered splices and diaphragms can sometimes overcome poor meshing near skewed
supports when a specific bearing orientation is required.

8561 An incident was resolved for the Bridge Modeler affecting steel I-girder bridges where, for
steel I-girders modeled as frames, the frame insertion point offset would be incorrect at
section transitions with different top flange thicknesses. When this happened, the insertion-
point offsets of the steel I-girders before the transition was incorrectly set to be the same as
that of the girder after the transition, meaning that the top of the top flange was aligned
instead of the bottom of the top flange (at the web-flange junction). This only affected the
single frame element just before the transition. When this occurred, the error could be seen
by looking at the extruded view of the undeformed shape. The effect on results was of
minor significance. This issue did not affect I-girders modeled as shells or as mixed. Models
from older versions affected by this issue will need to have their bridge objects updated
after opening in the new version in order to correct this error.

8604 An incident was resolved for the Bridge Modeler where the frame section properties
assigned to some of the frame objects generated when updating a bridge object could be
incorrect if the following sequence of steps had been performed: (1.) Run concrete frame
design on an existing bridge model, (2.) Update the bridge object, (3.) Run the analysis
without first saving the model. This error was not caused by running bridge design or rating
or any other type of frame design, only concrete frame design. Saving and re-opening the
model after updating the bridge object would avoid the problem. Results were consistent
with the frame section properties that were assigned to the members, and these could be
seen by displaying frame sections on the model or in the database tables.
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* Ticket Description
8633 An incident was resolved for the Bridge Modeler where the bearing links at the beginning

abutment would be incorrectly located
under a bridge section of type "Concrete Box Girder - Advanced" if the bridge section offset
X from reference point was non-zero and bridge object was updated as a spine model.
Results agreed with the model as generated.

8670 An incident was resolved for the Bridge Modeler where the feature "Mesh Superstructure to
Match Bent Bearing", which is part of the bent assignment to the bridge object, did not
always produce a reasonable slab mesh when set to "No", depending on the geometry of
the bridge spans on either side of the bent. Because of the need to connect the girders to
the slab as well as to produce meaningful section cuts for calculating superstructure forces
and moments, the option to NOT match the superstructure mesh to the bent bearing is now
limited to steel I-girder, steel U-girder, and concrete I-girder bridge sections under the
following conditions: (1.) The bent property must be of the single-bearing type. (2.) The
geometry of the spans before and after the bent must be straight, without any kinks or
curves. (3.) The same bridge section must be assigned to the spans before and after the
bent. (4.) If any parametric variations are assigned to the spans before or after the bent, all
dimension changes within and across the two spans must be linear and without any kinks. If
any of these conditions are not met, setting "Mesh Superstructure to Match Bent Bearing"
to "No" will be disabled when possible, or else it will be ignored when the bridge object is
updated if the conditions change after it has been set to "No".

8700 An incident was resolved for the Bridge Modeler where the bearings were sometimes not
properly located and connected to the grade beam at an abutment when the bridge
geometry at the abutment combined curve, super-elevation, skew, and grade. A similar
issue could occur for steel or concrete U-girder bridges with nonzero grade at the abutment,
even without curve or skew. When this occurred, the effect was visually obvious, and the
results agreed with the model as generated. This error did not affect abutments without
grade beams.

8713 An incident was resolved for the Bridge Modeler that affected bridge tendon generation in
certain cases: When a bridge tendon reference line was set to Bridge Center Line, the
generated tendon was correctly located along the centerline of the bridge section (the mid-
point between the two exterior girders), but the tendon length and distances were being
measured along the bridge layout line. This error would appear in the Bridge Tendon Data
form and in the generated tendons when the lengths along the bridge center line and along
the layout line were different, such as for curved or skewed bridges with unsymmetrical
transverse variation or with a horizontal offset specified for the bridge section.

8857 An incident has been resolved for the Bridge Modeler where the debond length defined for
Super-T girder tendons was being ignored when generating tendons for a bridge girder,
meaning the tendons were generated for the full length of the girder.

8865 An incident was resolved for the analysis of steel I-girder, U-girder, and precast concrete I-
girder bridge models in which an error message would display during creation of the analysis
model if the bridge slab contained any triangular area objects. When this occurred, the
analysis would not run and results were not available. This was not common as the Bridge
Modeler favors quadrilateral area objects for modeling the deck.

* 8872 An incident was resolved for the Bridge Modeler where bridge tendons located inside the
girders of a user-defined (Section-Designer) bridge section might not connect to the bridge
section if the widths of the top and bottom slabs the girder were quite different. This was a
rare case and could happen under either of the following two conditions: (1.) the girder cut
lines defined for the interior girders were not vertical, or (2.) the interior girder web was not
vertical and the bottom or top slab was not continuous at the sloped girder web. When this
occurred, the tendon was treated as external, producing different forces in the bridge
section and the tendons than expected.
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* Ticket Description
8925 An Incident was resolved for the Bridge Modeler where the vertical profile of bridge tendons

defined with respect to a girder reference line could be incorrect in regions where the top
slab thickness was varying due to an assigned parametric variation. This only occurred in
regions where the thickness was actually changing, not where the variation was a constant
zero or non-zero value. Where this occurred, the error in the vertical location of the tendon
was on the order of half the thickness variation at that location. This error did not affect
bridge tendons defined with respect to the bridge centerline.

8945 An incident was resolved where tendons defined in a Segmental bridge object could have
incorrect lengths, and could extend beyond the expected segment boundaries. This issue
affected v24.0.0 only.

* 8946 An incident was resolved for the Bridge Modeler where the new-model template for
Segmental bridges would cause an abnormal termination of the software if an invalid
numerical value was entered for the layout-line length at the beginning of the template.
Now an error message will be shown and the value can be corrected.

8949 An incident was resolved for the Bridge Modeler where adding a new segmental bridge
object from the ribbon command Bridge > Bridge Objects > New, and then trying to modify
the data in the Define Segmental Bridge Spans table on the Segmental Bridge Object Data
form the first time before clicking OK on the form would cause an expected error message.
Clicking OK, and returning to the form using command Bridge > Bridge Objects > Modify
would resolve the issue with no loss of data. This is no longer necessary. This issue only
affected new segmental bridge objects when another bridge object already existed. The first
bridge object created did not have this problem.

Data Files
Incidents Resolved
* Ticket Description
* 8835 An incident was resolved where, after importing a model file in text (.$BR, .B2K) or

database-table format (Excel, Access, XML) that contained a bridge-tendon with the start
and end distances defined as type Variable, the start and end distances would be set to zero
and the tendon definition corrupted such that the bridge object could not be updated. This
could be corrected by redefining the affected bridge tendons after importing the model.

Database Tables
Incidents Resolved
* Ticket Description
* 8448 An incident was resolved in which the design values were not reported correctly in the

Concrete Shell Design table for envelope-type load combinations. Now, the design values
reported (As1Top, As1Bot, As2Top, As2Bot, V1Ratio, and V2Ratio) for an envelope-type load
combination are the envelopes (only maxima) over all the designs for each contained load
case or load combination, including over all the steps within each of these load cases or
combinations. The same is true for each contained lower-level, envelope-type load
combination, except that an envelope-type combination will produce envelopes of the shell
forces rather than envelopes of shell designs if it is contained within a higher-level, non-
envelope load combination. For most practical cases, it can simply be stated that envelope-
type load combinations produce the more meaningful envelope of shell designs for different
sets of forces rather than the design for the envelope of these forces.

8572 An incident was resolved where the parametric variations defined for a bridge object could
be lost when importing the model from database tables (.B2K or .$BR text files, Excel,
Access, or XML formats) or when making changes using the interactive database editor. This
error only affected version 24.0.0.
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* Ticket Description
8585 An incident was resolved where some of the rebar data defined for a bridge object could be

lost when importing the model from database tables (.B2K or .$BR text files, Excel, Access, or
XML formats) or when making changes using the interactive database editor. This only
affected models where there was more than one bridge object and the number of girders
was different in each bridge object. The affected tables were "Bridge Object Definitions 23 -
Girder Rebar 2 - Transverse" and "Bridge Object Definitions 23 - Girder Rebar 3 -
Longitudinal".

Design – Concrete Frame
Incidents Resolved
* Ticket Description

8303 An incident was resolved in concrete frame design codes "AASHTO LRFD 2014", "AASHTO
LRFD 2012", and "AASHTO Concrete 07" in which the design moments were always
considered positive. This error affected the design of concrete columns for which the section
was unsymmetrical. Symmetric sections with symmetric rebars were unaffected by this
error.

8803 An incident was resolved where the longitudinal reinforcement quantity was reported
incorrectly in the right-click design details for members being designed according to the
AASHTO concrete frame design codes. The results on screen and in the tables were correct
and not affected.

Design – Slab
Incidents Resolved
* Ticket Description
* 8503 An incident was resolved to correct the design of concrete shell elements with only a single

layer of reinforcement in the middle of the section. Previously, after the design was
performed for the top and bottom layers of concrete, only the results for the top layer were
reported. This resulted in zero reinforcement being reported if only the bottom concrete
layer required reinforcement. Now the single layer of reinforcement at the middle that is
required to satisfy the design for both the top and bottom layers of concrete will be
reported correctly. Note that it is reported as being for the top layer in the contour plot and
table for concrete shell design results, although it applies for both positive and negative
bending, as applicable.

Design – Steel Frame
Incidents Resolved
* Ticket Description

8386 An incident was resolved for certain steel frame design codes where the critical buckling
capacity was not calculated correctly for unequal-legged angle sections having web height
(t2) greater than flange width (t3). However, the critical buckling capacity was calculated
correctly for equal-legged angle sections and for unequal-legged angle sections with flange
width (t3) larger than the web height (t2). The affected codes are as follows: AASHTO LRFD
2020, AASHTO LRFD 2007, AISC-ASD89, AISC 360-10, AISC360-05/IBC2006, Chinese 2018,
CSA S16-19, CSA S16-14, CSA-S16-09, SP 16.13330.2017, SP 16.13330.2011.
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Results Display and Output
Incidents Resolved
* Ticket Description

8290 An incident was resolved where the display of bridge-superstructure analysis, design, or
rating results in the bridge response display form omitted the response at girder-local
section cuts for steel I-girder bridges. The response was correctly plotted at the general (full-
width) section cuts. The girder local cuts could have been created by the Bridge Modeler for
capturing the response at section transitions, staggered diaphragm, or splices. This was only
a display issue. Analysis, design, and rating results presented in the output tables were not
affected and were present for all section cuts.

8474 An incident was resolved for bridge superstructure design where the D/C Ratio for Positive
Moment graphically displayed for the AASHTO LRFD steel U-girder bridge design service
check was plotted as zero for all locations along the length of the bridge. This was a
graphical display issue only. The results shown in the database tables and reports were
correct. No other results were affected.

Section Designer
Incidents Resolved
* Ticket Description

7418 An incident was resolved for Section Designer where the moment magnitude shown in the
moment-curvature contour plot was always based on the database units instead of current
display units. Note that database units are those in effect when the model is created and
that are used for analysis. This was a display issue only and did not affect the analysis
results.

Structural Model
Incidents Resolved
* Ticket Description

8272 An incident was resolved to fix incorrect or missing torsional constant (J) values for double
angles in the AISC14, AISC15, AISC14M and AISC15M XML section libraries. In these XML
section libraries, the J value for the double-angle sections were either incorrect or missing.
Upon import, missing J values were calculated (using formulas if the fillet radius was zero or
using FEM analysis if fillet radius was present), but the calculated values were different from
the expected values that should be twice that given in the same sections database for the
single angle comprising the double angle. This change involved updating the incorrect or
missing J values using the J values as available for the corresponding single angles in the
same section library.

8560 An incident was resolved where the properties of sections that were not available in the
XML section libraries were being set to zero when the sections were imported from the
respective libraries. All missing section properties for the section being imported are now
calculated at the time of import.

8940 An incident was resolved where the bounding boxes used for connecting tendons to area
(shell) elements were not correct for warped (non-planar) areas. The bounding box was
being drawn for the average plane rather than following the warped surface. In addition, for
certain rare cases, the connectivity of tendons to their bounding area elements could be
incorrect, causing the tendon to be connected to a neighboring element instead. When this
occurred, the effect was localized, and equilibrium was not affected. The connection to
bounding frame and solid elements was not affected. Finally, these bounding boxes are used
to apply bridge line and bridge area loads to area elements. These changes could have a very
small effect on the magnitude of such applied loads, and could likewise affect mass if these
loads are used in the mass source.
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User Interface
Incidents Resolved
* Ticket Description

8368 An incident was resolved where, for a frame object with non-zero end-length offsets, the
location of an assigned hinge reported in the right-click menu for the Analysis Model could
be incorrect. The Analysis Model right-click display has been changed so that the absolute
hinge location is reported relative to the total length of the analysis element and the relative
hinge location is reported relative to the clear length of the analysis element. The values
shown for the object model were already correct. This was a display issue only and results
were not affected.

8840 An incident was resolved for the Bridge Modeler affecting the Bridge Diaphragm Property
form where, for the Beam Type Diaphragm, the option "Modeled as Mixed Frame and Shell"
was always selected when opening the form even, if it had been previously unchecked and
saved. This was only an error initializing the form and did not affect the bridge model model
if Cancel was clicked, or the desired option was selected before clicking OK. The value of this
option used to create the bridge object could be seen in the database tables.

8851 An incident was resolved for defining precast I-girder frame section properties where the
Debond Point Distance values on the Tendon Layout Data form were not populated when
opening the form. When values were input and the form was closed with the OK button the
values were correctly stored, so this was only a user interface issue where the assigned
values were not recovered by the form. The values actually assigned and used could be seen
in the database tables.

* 8926 An incident was resolved where the software could terminate abnormally when attempting
to double-click the Cancel button immediately after the analysis was started. Note that a
single click is sufficient to cancel the analysis.


